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SeaClear Übungsprogramm  
in Deutscher Sprache  Wyklicky Udo 2009 
 
Herzlich Willkommen zum 
Übungsprogramm von Sea Clear 2, 
einem der besten Navigationsprogramme 
für Sportschiffe.  
Die neueste Version dieses 
Kartenplotter-Programms wurde 
gewissenhaft getestet und hat den Autor 
bereits weit über 30.000 Seemeilen 
gebracht – ohne Probleme.  
 
Hervorzuhebende Punkte an diesem 
kostenlosen Programm sind:  
 der gezielte Zuschnitt für Sportboote  
 Darstellung der wichtigsten NMEA 

Daten auf einem PC / Notebook  
(GPS Pos. , Wind, Tiefe, AIS…) 

 einfache Kalibrierung eigener Digitalkarten 
 leichte Menüführung beim Erstellen von Wegepunkten und Routen 
 Weitergabe dieser Daten an Radar, GPS oder Autopilot ect.  
 
 
Sinn und Zweck dieses Übungsprogramms ist, die ersten Schritte aufzuzeigen, mit denen wir: 

 Das Programm auf unserem PC installieren 
 Digitalkarten herstellen und in die Software einbinden 
 Das GPS am PC anschließen 
 Uns mit der Benutzeroberfläche vertraut machen und diese individuell einstellen 
 Die ersten Routen planen 
 Spezialanwendungen starten 

 
 
Diese Anleitung ist für die Nicht-Computer-Segler, die aber Spaß an ihrem Multitalent Laptop-
auf-dem-Schiff haben. Ich hoffe die versierteren Computerspezialisten verzeihen, dass ich 
mich vor allem an die Segler wende, die kaum den Startknopf am PC finden und daher jeden 
Schritt aufzeichne. Darüber hinaus gibt es ein paar Tipps, wie einfach die Installation von 
GPS und Computer ist, die ersten Schritte im Programm und das Erstellen von Wegepunkten 
und Routen.  
Ein ständiges Multitasking bzw. „hin-und-her-klicken“ können sie vermeiden, indem sie diese 
Anweisung einfach ausdrucken und mit der Papiervorlage die folgenden Schritte 
nachvollziehen.  
Neben dem SeaClear Programm und dem Kalibrationsprogramm ist auch die 
Betriebsanleitung ins Deutsche übersetzt. Sie beantwortet nach Durcharbeiten dieser 
„how2do“-Anleitung bestimmt noch offene Fragen und zeigt die weiteren Möglichkeiten des 
Programms auf.  
 
In dieser Anleitung sind direkte PC Befehle und Dateien zur Unterscheidung pink dargestellt. 
Tipps und Beachtungshinweise sind blau, Links sind blau unterstrichen. Betriebsteile die nur 
auf der CD in Deutsch (keine Downloadoption) sind, wurden grün dargestellt. 
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Installation 

 
Über das Internet könnten wir uns diese Freeware (wie der Name sagt – kostenlos) ständig 
als neueste Version herabladen. Wir finden sie unter www.seaclear.net/. 
Auf der SEA NavCD ist die aktuelle Version, komplett Voreingestellt und in Deutsch. Mit 
einem Rechtsklick auf das „Start“ – Symbol wählen sie ihren Explorer und dort ihr CD- 
Laufwerk. Suchen sie im Unterverzeichnis ..\Plotter PC\SeaClear die Datei sc_setup. Mit 
einem Linksdoppelklick wird die komplette Software installiert. Bestätigen sie dazu lediglich 
die Installationsschritte mit OK und Unzip. 
Die Software greift nicht in Windowsprogrammteile ein und kann auch direkt von einem 
Speichermedium (MMCard, USB-Stick… gestartet werden. BEACHTE: evtl. vergibt ein 
anderer Rechner hier einen anderen Laufwerkbuchstaben. Nur mit dem korrekten Pfad kann 
SeaClear die gewünschten Karten, Routen und Tracks laden. Die Software benötigt ohne den 
Kartenteil 3 MB. In der SEA NavCD-Version wird das Unterverzeichnis Hilfe automatisch  in 
das Verzeichnis von SeaClear verschoben. Es enthält die 
Betriebsanleitung, Übungsanweisung sowie -karten in Deutsch. 
Die Softwareteile sind bereits auf Deutsch voreingestellt – auch 
das MapCal_2. Diese Version gibt es leider im Internet nicht – 
sondern nur auf der SEA NavCD. Über den Arbeitsplatz  (z.B. 
Windows-Schalter links unten rechts klicken und Explorer 
wählen) Programme > SeaClear können sie mit einem  

Rechtsklick auf die Datei SeaClear_2.exe und 
MapCal_DE.exe, über die Funktion Senden an > 
Desktop ein Ausführungs-Icon auf dem Bildschirm erstellen.  
 

  Nach dem Installieren werden die Neugierigen unter ihnen, die nun bereits mit einem 
Doppelklick die Software seaclear_2.exe aktivieren haben, etwas enttäuscht sein. Bis auf 
einen Seitenrahmen mit Minimaldaten und Weltkarte, gibt es noch nichts zu sehen – mit den 
folgenden Schritten aber sind wir schnell am Ziel - unser Boot „live“ mit allen Daten auf dem 
digitalen Wasser zu sehen. 

 
 

Herstellen eigener Digitalkarten 
 
In 2 Optionen wird aufgezeigt wie man SeaClear, das ja keine eigenen Karten (bis auf 
Überflieger) zur Verfügung stellt, mit Karten nutzen kann. Option 1 nutzt vektorisierte Karten 
anderer Kartenplotter, Rasterkarten oder Satellitenbilder (z.B. von Google Earth). Eigentlich 
ist Papierkarten einzuscannen nicht mehr nötig – da wir ca. 20.000 Amtl. Digital-Seekarten 
kostenlos erhalten können – wie steht in der Anleitung. Option 2 behandelt wie man eigene  
Papierseekarten digitalisiert.  
 
Option 1 
Das Umwandeln von 
bereits vorhandenen 
Digitalen Bildern aus 
anderen Nav 
Programmen die z.B. 
Vectorkarten oder 
Satellitenbilder 
verwenden, wird in der 
Datei Digitale 
Kartenerstellung.pdf 
erklärt. Sie finden es 
auf der SEA NavCD 
unter ..\Plotter 
PC\SeaClear\Hilfe.  
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Option 2 
 
Jeder verantwortliche Skipper hat einen ausreichenden Satz an aktuellen (Papier-) Seekarten 
auf dem Schiff – warum diesen nicht auch digital nutzen. Ihr Eigentum dürfen Sie, rechtlich 
problemlos, für Ihren Gebrauch digitalisieren und somit auf den elektrischen Medien 
darstellen bzw. nutzen.  
Das „Einlesen“ der Teilkarten wird hier mit einem handelsüblichen A4 Scanner durchgeführt 
um Teile oder eine ganze A0 Karte einzuscannen und zusammenzufügen.  
Haben sie die Möglichkeit bei einem Copy-Shop die ganze Karte eingescannt zu bekommen 
– umso besser. 
Vorgabedaten für den Scanner sollten sein: 

o 75 – 150 dpi 
o maximal 265 Farben 
o gespeichert und komprimiert als *.png (selbst dann hat eine A0 noch bis zu 10 MB) 

 
Die im Übungsprogramm herabladbaren Karten dürfen sie nur zu Übungszwecken 
verwenden. Diese sollen ihnen aber zeigen, wie einfach es ist, damit zu arbeiten - falls Sie im 
Moment nicht Karte oder Scanner zur Hand haben. Speichern sie nicht mit der Endung *.jpg 
– hier werden bei Plakativen Darstellungen (Tiefenangaben z.B.) die Übergänge unscharf. 
 
Da sie zu jedem Scanner auch die nötige Software erhalten haben, können sie diesen Scann-
Ausschnitt mit ihrer oder der Freeware Irfanview (http://www.irfanview.com) öffnen (auf der 
CD unter ..\Tools\irfanview*exe). Irfan View ist ein Graphik/Foto Programm mit dem in 
erstaunlicher Geschwindigkeit auch große Bildformate verändert werden können. 
Bevor wir aber die Karte scannen, müssen wir sie in A4 Formate mit Überdeckung einteilen. 
Mehr als 8 x A4 Scanns sollten sie nicht „zusammenkleben“ – sonst wird das Bild zu groß 
(und ältere Rechner stoßen an ihre Grenzen). 
Drehen Sie nun Ihre Karte auf den Rücken und messen als erstes bis zum Kartenrand, ab 
dem Sie einscannen wollen. Ab dann teilen Sie die Karte in 20cm breite und 28cm hohe 
Felder ein.  

 
Rechts beginnend mit Feld 1 bis 4 scannen Sie nun 
die ersten 4 Kartenteile ein. Damit durch Lichteinfall 
die Kanten des Scanns nicht allzu unscharf oder 
unsauber werden, können Sie den Scannerdeckel mit 
einem Buch beschweren oder mit einem 
lichtundurchlässigen dunklen Tuch abdecken. Sind 
die Ränder zum Scanner-Deckel sehr hoch müssen 
Sie evtl. falzen.  
 Nach den ersten 4 Scanns drehen Sie das 
Kartenblatt um 180° und beginnen mit Scan Nr. 
5u.s.w. 
 

Unsere Karte ist zwar nun eingescannt, muss aber noch nachbearbeitet werden. Wir machen 
dies in 5 einfachen  Schritten: 
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 Irfanview-Software aktivieren 
 Datei einladen Datei > Öffnen (Arbeiten sie bei der ersten Übung bitte mit den 

mitgelieferten Karten und noch nicht mit ihren Eigenen). Suchen sie den Pfad in den 
sie die 3 Übungskarten kopiert haben, sie sollten in ..\seaclear\Hilfe zu finden sein) 

 Drehen  Da die Datei horizontal liegt können wir sie mit  Bild > Rechts drehen optisch 
senkrecht stellen 

 Schärfen Damit Details besser hervorgehoben werden wird das Bild nachgeschärft. 
Bild > Effekte > Einstellungen/Vorschau > Sharpen > Value: vom voreingestellten 
Wert 20 auf 30 ändern. 

 Farben anpassen Mit dem Werkzeug Bild > Farben ändern kann der Helligkeitswert 
und das Gamma nachgestellt werden (hier muss für jede Karte etwas experimentiert 
werden). 

 Speichern Das umgewandelte Bild sollte als neue Datei gespeichert werden, da 
sonst Korrekturen nicht mehr möglich sind. (z.B. Speichern unter map1a.png) 

 
In gleicher Weise verfahren wir mit der Übungskarte map2.png ! Gespeichert unter 
map2a.png?  
Mit dem Windows Paint Programm können nun die Karten zusammengefügt werden. 
Man klickt map1a.png rechts an Öffnen mit… > und wählt  Paint. Paint ist das 
Zeichenprogramm jedes Windows Betriebssystems. Start > Alle Programme > Zubehör > 
Paint. 
Beachte: Bei Windows95 muss 
vorher das Bild als *.bmp 
umgewandelt werden. 
Nachdem das Bild geladen ist wird 
die Datei nun vergrößert.  Bild > 
Attribute. Im daraufhin geöffneten 
Fenster werden die Pixelwerte der 
Breite von 1401 auf 3000 erhöht. Die 
Pixelwerte der Höhe von 1901 
korrigieren wir nur minimal auf 2000. 
Sollten aber Bilder darunter gesetzt 
werden, kann auch hier der Wert 
deutlich erhöht werden. 
Wir öffnen ein Zweites Mal über den 
Arbeitsplatz die Datei map2.png mit 
Rechtsklick Öffnen mit… > Paint. Über Bearbeiten > Alles markieren > Rechtsklick im Bild 
Kopieren haben wir es temporär gespeichert und schalten in der Fußleiste auf Paint mit 

map1.png (bmp). Hier klicken wir in 
das Werkzeug der Palette ganz links 
oben (den gestichelten Rahmen). 
Nun verschieben wir den Rollbalken 
bis wir nur noch einen kleinen 

Ausschnitt des map1.png am linken Rand erkennen 
können. Mit einem Rechtsklick im noch leeren 
weißen Feld > Einfügen taucht unser map2a.png auf. 
Mit links gedrückter Maustaste wir das Bild nun exakt 
auf die Nahtstellen verschoben. Dabei ist es auch 
möglich am Rollbalken weiter nach links/rechts oder unten/oben zu rollen. Falls sie aber in 
das alte Bild klicken ist das neue Bild „fest“. Bei Bedarf kann aber dieser Befehl mit 
Bearbeiten > Rückgängig annulliert werden.  
Wenn sie nun an den optisch sichtbaren Kartenrand rechts unten rollen und den Mauszeiger 
genau auf die Ecke setzten, zeigt Paint die Koordinaten rechts unten an. Wir wählen erneut 
Bild > Attribute und geben diese Koordinaten ein (z. B. Breit 2709  und 1944 Hoch) OK. 
Sofort ist unser Bild nur noch so groß wie wir es benötigen. Nun dürfen wir die Größe aber 
nicht mehr ändern. Im nächsten Abschnitt wird das Bild kalibriert und hier weist das 
Programm jedem Bildpunkt (Pixel) eine Koordinate zu. Wenn wir also etwas wegschneiden 
oder verkleinern würden, könnten sich diese Adressen nicht mehr decken. Nachbearbeiten 
dagegen können wir immer wieder. Wie z. B. ein neues Leuchtfeuer einzeichnen oder ganze 
Info Hafenkarten in nicht benötigte Ecken platzieren (Diese sind aber nicht kalibriert!). 
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Wichtig beim Speichern ist die Endung, also .png eintragen oder wählen. MapCal von 
SeaClear kann fast alle Bildformate erkennen und wird sie komprimieren (falls sie das WCI 
Verfahren nutzen – siehe weiter unten) 
Die Dateinamen sollten einen Bezug zu Ihren Karten, oder dem Seegebiet haben. (also z.B. 
Adria_NE oder DE_4812) So sind sie später leichter zu finden sind – falls sie Änderungen 
daran vornehmen wollen.  
  
Speichern sie die Karte als Carriac.png unter ..\SeaClear\charts ! 

 
 

 
Ein Beispiel hierzu: Nach-
Kolorierung  und Entfernen von 
Daten, die für elektronische 
Seekarten nicht mehr notwendig 
sind, wie Hilfslinien, Windrosen 
usw.. 
 
 
 
Im Windows Paintprogram 
können diese Pixelbilder völlig 
umgemalt werden.  
 
Hier ein Beispiel wie sie einfache Seekarten mit Bildausschnitten z.B. von Google Earth 
http://earth.google.com/ nachbereiten können. 
 

 
 
Dies ist natürlich eine ganz schöne Arbeit, macht aber Spaß und sie werden mit dem 
künftigen Seegebiet sehr vertraut.  Weiter zur Kalibration! 
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Kalibrierung der Karte 
 

Nun konvertieren und kalibrieren (was ist das? =  verändern und Koordinatenzuweisung) 
wir unsere Seekarte carriac.png.  
Das heißt, wir weisen der Karte für jeden Bildpunkt (= Pixel) Koordinaten im Format 
G°M.Dezimal’ zu. Die Software kann eingehende GPS Daten nun auf dem Bildschirm 
aktualisieren und unser Schiff wird dort dargestellt, wo wir uns befinden. Das Konvertieren (es 
ist nicht zwingend nötig!) erleichtert aber vor allem älteren PC die Berechnung des 
Schiffortes, da nur der Bildschirmausschnitt und nicht die ganze Karte berechnet wird. Beim 
Konvertieren wird ein neues verdichtetes WCI-Datei-Format geschaffen. SeaClear schreibt 
und liest die Koordinationsdaten direkt aus dieser Karte anstatt von einer externen Datei und 
lädt nur den sichtbaren Bildschirmkartenteil, womit viel Arbeitsspeicher gespart wird. Im 
Gegensatz zu anderen Programmen wird nur eine Datei für eine Karte gebraucht – da in 
diesem Format Bildinformationen, Infos und Kalibrierung stecken. 
 

Als erstes öffnen wir dazu das MapCal-Werkzeug. ..\SeaClear\MapCal_DE.exe 
Die Deutsche Version wurde automatisch geladen. Im Original-Download gibt es diese 
Version nicht – erklärt werden beide Versionen.  
Die grün dargestellten Befehle beziehen sich auf die Deutsche Version von MapCal_DE 
Falls sie mit dem Original arbeiten, doppelklicken sie im Verzeichnis: 
..\SeaClear2\mapcal_2.exe .  
Wir haben uns entschlossen das WCI 
Format zu nutzen. (Ansonst 
überspringen sie diesen Teil, haben 
aber zur *.png Datei eine Chartcal.dir 
Datei, die von allen Karten im Pixel-
Format genutzt wird. Sollte eine Karte 
gelöscht werden sind die Daten dafür 
immer noch in dieser Chartcal.dir Datei)  
Mit Tools > Convert > Singel File to WCI (Bearb. > Ändern > Geladene Karte als wci) öffnet 
sich ein Fenster, in dem unsere PNG aufgeführt sind (sonst müssen sie den Verzeichnispfad 
prüfen  = ..SeaClear\charts).  
Wir wählen carriac.png mit einem Doppelklick und ein weiteres Fenster öffnet sich. Es ist das 
Zielfenster (und kann das gleiche Verzeichnis sein). Dort liegen bereits Kartendateien *.wci.  
Wir bestätigen das konvertieren nach *wci mit Speichern.  
Nun dauert es einen Augenblick, bis die alte Datei in eine neue umgewandelt wurde.  
Nächster Schritt ist die Kalibration der Karte. Wir vergeben also Koordinaten in die Karte. 
Über >File >Open Image  (Datei > Öffne Bild) gelangen wir in ein Fenster, indem das ganze 
SeaClear2 Verzeichnis aufgeführt ist. Doppelklicken sie hier auf Charts. Nun sollten mehrere 
Karten auftauchen.  
Tipp: Wenn ihre Karte eine andere Endung hat, z.B. *gif, ändern sie im Rollmenü von 
Dateityp Chart File in Any File – nun wird sie angezeigt.  
Eine davon kennen wir schon und brauchen die png-Dateien nicht mehr.  
Die einzelne Datei mit der rechten Maustaste anklicken > löschen. Dadurch sparen wir 
Speicherplatz und verhindern einen Konflikt beim nachfolgenden Update. 
Warum? MapCal wird nach dem Kalibrieren unserer Karte das gesamte Verzeichnis 
durchsuchen und uns melden – da ist 1 Karten die nicht kalibriert ist – Was sollen die dort?  
Sie laden aber nun carriac.wci  mit einem Doppelklick. Es öffnet sich ein Info-Fenster für 
unsere Karte.  
 
 
Diese Karten-Informationen (die Sie Ihrer Originalpapierkarte entnehmen) sollen uns später 
helfen, im Programm SeaClear 2 Informationen abzurufen.  
 
Erneut vergeben wir also einen Kartennamen (das kann, muss aber nicht der Dateiname 
sein). Er dient nur zur Information die wir später direkt aus SeaClear lesen können (Datei > 
Karteninfo). Für diese Übung wählen wir Carriacou, Grenadines. 
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Scale (Maßstab) 
Wir ändern die Scale indem wir die Vorgabezahl löschen und  1/25 000  eingeben (1cm auf 
der Karte entspricht also 25000cm in Wirklichkeit).  
 
Priority (Vorrangstufe) 
wir können Prioritäten vergeben (1er Karten werden bei selbem Maßstab vorrangig geladen!)  
und wissen auch wie aktuell diese Karte ist.  
 
Depth Unit 
Bei Depth Unit (Tiefeneinheit) wählen wir, indem wir auf den Pfeil klicken, Meter. Einige 
Karten sind ja noch immer mit Fathom oder Feet versehen. Dies dient nur zur Information – 
Ihr GPS und auch SeaClear wissen nicht wie tief es wirklich ist, außer sie haben den NMEA – 
Datenbus gekoppelt – dann haben sie die Tiefen-Daten in einem eigenen Feld in der 
Navigationsleiste (siehe GPS Anschluss) 
 
Projection 
Für die Definition der Karten-Projektionsart aktivieren wir das Auswahlmenü (in den Pfeil 
klicken) und wählen für unser Beispiel Mercator  
 
Kartendatum 
und schließen mit der Überprüfung des Kartendatums (meist ist es WGS 84) ab. 
 
Other Information (Weitere Info) 
Unter Other Information könnten wir, wann und wer diese Karte eingescannt und kalibriert hat 
schreiben.  
Es mag also so aussehen: 
Scanned by mein Name 05/200? 
Kartenaktualisierung 09/1999 
 
Das bestätigen wir mit dem OK Schalter. 
In der Kopfzeile wird nun auch schon der von uns vergebene Kartenname angezeigt. 
Nun wird kalibriert - indem wir irgendwo, (oder exakt) in der Nähe des Grauen Vorgabe 
Kreuzes auf der Karte links oben, rechts die Maus klicken. Es erscheint ein Untermenü und 
hier wählen wir Add New Cal. Point.  

Lat/Lon Eintragungen sind im Format: G°M’.Dezimal N/S oder E/W zu machen. 
Zeigen sie in das entstandene Quadrat mit Kreuz, links klicken und halten und verschieben 
sie es bis es sich mit dem grauen Karten Kreuz deckt. Dies ist auch mit den Pfeilen links 
möglich. 
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Auf der Übungskarte ist dieses Kreuz vorgegeben da sie ja die Originalkarte nicht haben und 
am Kartenrand die 
Lat/Lon Daten 
schwer ablesen 
können.  
 
Tragen sie in die 
Lat/Lon Felder nun 
die auf der Karte 
angegebenen 
Koordinaten ein. 
ACHTUNG: 
Vergessen sie 
nicht das 
Vorzeichen E (Ost) 
auf W (West) 
umzustellen. 
Bei ihren eigenen 
Scans (gescannten 
Karten) brauchen 
sie sich nur einen 

Punkt weit links oben suchen. Dies muss nicht unbedingt ein Gitterpunkt sein, auch eine 
Tiefenangabe oder eine Landmarke, die sie mit dem Zirkel herauslesen ist ausreichend. 
Haben sie nicht allzu viele Kartenteile zusammengeklebt reicht es nun, recht rechts weit 
unten einen 2ten Punkt zu bestimmen. Da beim scannen aber immer minimale 
Verschiebungen möglich sind, können sie endlos viele Kalibrierungspunkte vergeben. 
Unsere Übungskarte hat keinen solchen Knick!  
Nun rollen wir mit den Rollbalken die Karte zur rechten unteren Ecke. 
Erneut klicken wir rechts, wählen Add New Cal. Point und tragen die Daten im nun 
veränderten Fenster  Point 2 ein.  
Im Rollmenü Grid wählen wir > Normal Grid (Normales Gitter) und Activate Changes, 
(Aktiviere Änderungen) pinkfarben wird über unsere Karte ein Gitter (=Grid) gelegt. Bei Bedarf 
können also weiter Punkte vergeben werden – bis das Gitter sauber aufliegt. 
Da sich Fehler multiplizieren  (und wer kennt das als Segler nicht) vergeben wir einfach noch 
ein paar Gitterpunkte und rollen die Karte noch etwas höher. Ab sofort werden die Werte 
vorgegeben und müssen nur noch minimal verändert werden. 
Wie gehabt klicken wir rechts Add New Cal. Point, bezeichnen die Punkte neu indem wir die 
entsprechenden Koordinaten eingeben und wählen erneut Activate Changes (Aktiviere 
Änderungen). Sobald wir mit dem Gitter über der Originalkarte zufrieden sind, speichern wir 
dies mit File > Save Calibration (Datei > Speichern).  
Um das ganze jetzt in unsere Kartenliste (ohne diese findet SeaClear die Karte nicht) 
einzutragen wählen wir Tools > Autoload List > Scan for New Charts. (Bearb. > 
Kartenverwaltung > Suche nach neuen Karten) Das Resultat bestätigen wir und führen erneut  
Tools > Autoload List  > Recreate (Bearb. > Kartenverwaltung > Neue Liste erstellen (die evtl. 
Meldung ersetze scan können sie ignorieren) durch. 
Schnelle Rechner führen nun, für das Auge kaum erkennbar, 
einen Scan und Search durch und melden uns das Ergebnis – wir 
haben 5 (oder schon mehr?)  WCI Karten im Verzeichnis und 
bestätigen dies. Überprüfen können wir dies mit File > Open 
From List (Datei > Öffne aus der Liste) und schon wird auch 
unsere neue Karte mit angezeigt.  
Das war‘s – wir können MapCal schließen. Ein noch geöffnetes SeaClear muss auch 
geschlossen werden 
Beim nächsten Start von SeaClear würde ab sofort die beste Karte für die GPS Position 
automatisch geladen.  
 
Ein kleiner Tipp für Segler, die Schwierigkeiten bei oben angeführten Prozeduren haben oder 
noch keine eigenen Papierkarten für das jeweilige Revier besitzen. . Wie man aus einem 
kostenlosen Pool aus über 20.000 amtl. Seekarten Rasterkarten für SeaClear erstellt, ist im 
..\SeaClear\Hilfe\Digitale Kartenerstellung.pdf erklärt. 
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Fremdkarten (z.B. bmp,kap/bsb…) 
Der Seekartenplotter SeaClear erkennt fast alle Bildformate. Ist das Bild/Karte aber nicht 
kalibriert öffnet sich automatisch ein Kalibrierungsfenster. Die Daten sind dann einzutragen 
(siehe Anleitung weiter oben). 
Karten die bereits vorbereitet sind (WCI oder kap/bsb) müssen nur in das Verzeichnis 
..\SeaClear\charts kopiert werden.  
Wird dabei ein Unterverzeichnis angelegt muss mit der MapCal_DE dieser Pfad 
aufgenommen werden (siehe Bild unten). 
Bearbeiten - Erstelle Verzeichniss - << klicken und nach den Unterordnern suchen. 
In MapCal_DE (Verwaltungsinstrument für SeaClear) muss jede Änderung der 
Karten mit einem Update über  
Bearbeiten > Kartenverwaltung > update 
bestätigt werden! 
SeaClear kann KEINE Vectorkarten lesen - er kann also nicht direkt die Seekarten von 
z.B. NaviChart einlesen! 
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Das GPS am PC anschließen 
 
Dies ist der größte Stolperstein für viele Nautiker und Segler. Am einfachsten funktioniert es 
mit einer GPS Maus mit einem Kabel zum Com1 Port – hier wird aber der grüne Anschluss 
der Externen Maus für die Stromversorgung genutzt. Es muss weder an der Software noch 
am PC/Laptop etwas umgestellt oder Treiber installiert werden.  
Leider haben moderne PCs/Laptops oder Netbooks keinen Com1 Eingang mehr. Siehe RS 
323 Anschluss unten im Bild. Achten sie also darauf eine GPS Maus einzusetzen die einen 
USB Anschluss hat. Die nötigen Treiber um eine virtuelle Schnittstelle herzustellen werden 
mitgeliefert oder können im Internet herab geladen werden. 
Beachte: Bei Vista gibt es Treiber für 32 oder 64 Bit Versionen. Win 7 aktualisiert (online 
vorausgesetzt) die Treiber automatisch. Ohne Treiber funktioniert das GPS nicht! Nach der 
Installation notieren sie den virtuellen ComPort und die Baudzahl. 
Beachte: Nutzen sie immer denselben USB Port sonst vergibt die PC Steuerung evtl. einen 
weiteren ComPort – man müsste die Software dann jeweils auf den richtigen ComPort ein-
/umstellen. In jeder Software ist dieser ComPort und die Baudrate einzustellen. Bei Bluetooth 
GPS übernimmt die Bluetooth Software die Treiberinstallation. Bluetoothgeräte funktionieren 
aber nur bis zu 6 Stunden. Wenn möglich sollten die GPS-Geräte an eine 12V 
Dauerstromsteckdose (oder ihr Törn ist nicht all zu lange).  
Nutzen sie dazu auch die Betriebsanleitung ihres GPS.! 
 
Zur Einspeisung des GPS Signales von Bord-GPS brauchen wir? 
 Ein NMEA (= Standart Datenprotokoll für die Seeschifffahrt ) kompatibles GPS (einige 

kleine Hand-GPS sind dies nicht) oder vorzugsweise eine GPS-Maus 
 Ein Mehrlitzen-Kabel vom GPS bis zu ihrem PC/Laptop an Bord (dies und unten 

aufgeführtes entfällt bei GPS Mäusen) 
 Einen 9 Pin Mama (also Löcher, keine Stifte) Stecker für den Com1-Eingang 
 Evtl. ein Adapterkabel Com1 > USB 
 Etwas Zinn, Elektrowerkzeug und einen kleinen Lötkolben 
 
Ihrer GPS-Betriebsanleitung entnehmen sie die Litzenfarbe für die 2 benötigten Kabel:  
Masse, und Tx (Daten transmite = senden).  
Beachte: einige GPS Geräte haben für den Datenaustausch eine eigene Masseleitung (Data-
Ground).  
Sind mehr NMEA -kompatible Geräte im Schiff eingebaut (der sogenannte NMEA-Daten-Bus) 
muss ein Multiplexer eingesetzt werden (s. weiter unten), damit der PC Wind-, Tiefen-, 
Autopilot- , …- Daten verarbeiten kann.   
 
 
 

Achtung: die Tx (PIN 3) – Daten dürfen nicht direkt vom GPS an den Autopilot geleitet 
werden. Daten die SeaClear nicht weiterverarbeitet, werden ungeprüft durch seine Software 
durchgeschickt, einige Daten aber werden umgesetzt und der „Leser“ (z.B. der Autopilot) 
braucht diese gewandelten Daten. 
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Nun muss Masse auf Pin 5, Rx auf 2 und Tx auf 3 gelötet werden (falls Daten weitergeleitet 
werden sollen). Dazu sind die kleinen Stecker vorne beschriftet.  Abschließend verbinden sie 
den Stecker mit dem Com1 Port ihres PC. Ist dieser belegt durch ein Wetterfax oder andere 
Geräte, nutzen sie den Com2 Port. Moderne Laptops haben solche 2 Com1 Ports aber oft 
nicht – was nun? Die Computer Industrie bietet dazu Verteilerdosen an oder sie stecken 
einfach bei Bedarf immer um. Die neuen Laptops haben selbst diese Com Schnittstelle nicht 
mehr – es gibt aber Adapter für den USB – Eingang oder sie nutzen gleich eine GPS Mouse. 
Arbeiten sie mit Com2-256 muss dies der Software mitgeteilt werden. (siehe Bearbeiten > 
Einstellungen > Com in SeaClear ). Für eine Prüfung des GPS Signals (kommt überhaupt 
etwas und an welchem Port?) können sie die Software GPS Test nutzen (sie finden sie auf 
der SEA NavCD ..\Nautik – lesen sie die dortige Hilfe GPS Test how2do.pdf) 
Im GPS –Setup sind folgende Einstellungen zu prüfen.  

- Arbeitet es mit WGS 84, NMEA 183 2.0 (bei Magellan NMEA 183 B) 
- und einer Bautrate (Transportgeschwindigkeit) von 4800. (Ausnahme AIS!) 
- Ist das GPS zum senden aktiviert?  

Nur in ganz wenigen Einzelfällen muss in SeaClear oder dem GPS noch weiteres ein- / oder 
umgestellt werden.  

 
 
 
Tipp: GPS Mouse – diese funktioniert bei GFK-Booten meist direkt im Schiff, bei Alu- und 
Holzschiffen sollte sie z.B. am Fenster der NavEcke platziert sein – muss also nicht mit 
externer Antenne betrieben werden. Falls die GPS Maus über USB angeschlossen ist, wird 
ein anderer Com Port belegt.  GPS Test zeigt nach Anklicken von Scan Com Port wie dieser 
Port heißt! Führen sie den Test evtl. auch mit 9600 Baud durch – einige Sirf III Mäuse 
arbeiten mit einer höheren Baudrate. 
 

 
 
 
 
 
 
 
 
 

SeaClear kann noch viele weitere Daten darstellen. Sollten sie also ein NMEA fähigen 
Windmesser, Tiefenmesser oder AIS Empfänger haben müssen diese an einen Multiplexer 
angeschlossen werden.  
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Dieser Multiplexer gewährleistet, dass ihr PC die verwirrend vielen, gleichzeitig erhaltenen 
Daten, auseinander sortiert bekommt.  
 
 
Bezugsquellen für eine Eigen-Installation sind z.B:  www.svb.de  
 
Die Verkabelung und das Anlöten der Schnittstellen ist bei allen Steckern dieselbe. Neue 
Laptops die keine Com1 Buchse mehr haben müssen nun noch einen Wandler einsetzen. 
Hier werden die NMEA Daten USB fähig umgesetzt. Praktisch funktioniert das mit einer 
Kupplung in die der 9pin Stecker eingesteckt und an der USB Seite 
in den Laptop gesteckt wird. Über eine eigene Software wird im 
Laptop ein virtueller ComPort erstellt und dem Stecker zugewiesen. 
Die Software simuliert einen ComPort und zeigt diesen an. In diesem 
Fall muss dies aber auch SeaClear mitgeteilt werden. Über 
Bearbeiten > Einstellungen > Com  wird der neu verwendete 
ComPort eingestellt. Ab sofort können Wassertiefenalarme vergeben, AIS-
aurüstungspflichtige Schiffe angezeigt oder der Windwinkel am Schiffsymbol dargestellt 
werden. So verfahren sie auch wenn lediglich eine GPS Maus per USB angeschlossen 
werden soll. 
Na, schauen wir was passiert und klicken die seaclear_2.exe an.
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Die Benutzeroberfläche 
 
Nach dem Aktivieren (durch Doppelklick) der Datei seaclear_2.exe oder dem 
erstellten Bildschirm-Icon (der Verknüpfung zum Programmstart) lädt die Software 2 
zusammenhängende Rahmenfenster.  
Der Datenrahmen, die Navigationsleiste, erscheint rechts vom Kartenfenster (diese kann 
auch nach links versetzt oder geschlossen werden). Unabhängig was nun passiert orientieren 
wir uns auf dem Bildschirm und da uns das leichter in Deutsch fällt, wurde die Deutsche 
Sprache bereits eingestellt.  
Sonst = Klicken sie in Tools > Properties  und in dem geöffneten Fenster im Language-Abteil 
auf den Schalter mit den 3 Punkten (…). Wählen sie aus dem erneut geöffneten Fenster 
German_2.lng mit einem Doppelklick. Sichern Sie diese Einstellung, mit Save.  
Sieht ihr Bildschirm nun so aus?  
 
Irgendetwas mit dem Dateneingang des GPS 
stimmt nicht! 
Es ist falsch,  nicht angeschlossen, oder kann in 
ihrer Wohnung keine Satellitendaten empfangen 
(wie wär‘s mit dem Fensterbrettl). Ist er an den 
Com2 Port angeschlossen oder stimmt die 
Übertragungsrate nicht? – klicken Sie in 
Bearbeiten > Einstellungen > Com und ändern 
diese. Zum Planen oder Routenerstellen kann 
SeaClear aber auch ohne GPS verwendet werden 
(s. dort). 
 
 
 
 
Im grünen (hier grauen) Bereich sind wir, wenn das GPS Fenster Daten anzeigt. Falls sie dies 
von Zuhause aus probieren ist ihr Schiff halt in Zürich, München oder Wien und wird nicht 
sehr schnell „live“ irgendwo hinfahren.  
Wenn sie nun mit der Maus (die sich auch noch ständig ändert) über den Bildschirm fahren, 
werden Infos beim Darüberfahren (Aktivieren) in der Navigationsleiste kurz erklärt.  
 

 
Befindet sich das Kreuz im 
Kartenteil, erhalten sie die 
Position der Maus sofort 
errechnet und dargestellt im 
rechten unteren Fenster, 
mit Richtung und 
Entfernung zum GPS. Die 
einzelnen Angaben sind im 
Manual auf der CD 
../SeaClear/Manual oder als 
Download (Handbuch - 
auch dazu gibt es eine 
deutsche Ausgabe, siehe 
Download) erklärt.   
Sobald NMEA-fähige 
Zusatzgeräte 
angeschlossen sind und ihr 
Bildschirm ausreichend 
groß ist, werden auch Wind-
, Elektrokompass- und 
Tiefenangaben dargestellt.  
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Blättern sie nun doch einmal mit Bearbeiten > Einstellungen in die Optionen. Ändern sie die 
Grundeinstellungen aber nur, wenn sie die Funktion auch verstanden haben.  So können sie 
SeaClear personalisieren. Farben, Anzeigen und Aktionen können beliebig verändert werden. 
Diese Einstellungen werden in einer eigenen Datei festgehalten und müssen nicht ständig 
neu geladen werden. Sie können aber jederzeit zurück – oder erneut umgestellt werden.  
Auch ohne große Planung ist es ein „Aha“-Erlebnis sobald ihr Schiff den Hafen verlässt und 
sie in Sekunden sehen, wo sie sind, wohin und wie schnell das Schiff  fährt (Normalmodus).  
Es kann eine Peilung geprüft werden, indem sie mit der Maus vom dargestellten Schiff in die 
gewünschte Richtung ziehen (Tatsächlich das Kap liegt in 235°) – nur erhalten sie nun sofort 
darüber hinaus die Information, wie weit es noch weg ist. Der Track weicht von unserem Ziel 
deutlich ab – „Rudergänger 10° mehr anluven, hier ist Strom“ (oder packt unsere Jacht doch 
keinen Wendewinkel von 35°?).  
 

Ihre Navigation wird nicht leichter – aber die Berechnung! 
 

Noch immer müssen sie ihr Schiff spüren, sobald sie in den Flachwasserbereich kommen - 
draußen rundum sehen und ein Auge auf das Wetter haben – aber zwischendurch können 
Sie die Mitsegler mit solch einem Eindruck überraschen. Hier der Zweitbildschirm im Cockpit 
einer Jacht die nachts von Grado nach Koper segelt. (Bearbeiten > Einstellungen > Andere 
der Nachtmodus im Filter(3) auf -40, also negativ verändert) 
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Routen planen 
 
Routen sind eine Reihe von Wegepunkten, die aneinander gehängt sind.  
Eine Route kann:  

 neu erstellt werden  
 aus vorhandenen Wegepunkten kombiniert werden  
 mit einem alter Track zu einer Route umgestellt werden.  

Auch können mehrere Routen aneinandergehängt werden. Fährt unsere Jacht 
vollautomatisch, müssen (Option von Benutzer Einstellungen) wir, mit Erreichen eines 
Wegepunktes (Alarmton) den nächsten Wegepunkt bestätigen und können die Segel neu 
trimmen.  
Zum Planen der Route benötigen sie kein GPS – wir können also bereits Zuhause auf 
demselben oder einem weiteren PC, ohne das GPS umzumontieren, vorarbeiten. Verbleibt 
der PC auf dem Schiff benötigen sie nur die SeaClear Software und ein Speichermedium 
(USB Stick, Diskette…). Speichern sie die benötigten Karten (falls sie nicht als Update eh 
Zuhause sind) und beginnen sie eine neue Route. 
Der Automatik Modus muss dazu ausgeschalten sein! 
Damit sie mit der Installation von Karten weiter vertraut werden, verschieben sie nun die 
vorbereitete Übungskarte adria_ne.wci von ..SeaClear\Hilfe nach ..SeaClear\Charts und mit 
dem Softwareteil MapCal (das Kalibrierungswerkzeug!) aktualisieren (falls nötig) sie die 
Karteneinträge.  
Wird mit File > Open From List die Karte adria_ne.wci angezeigt? 
Wird mit Datei > Öffne Kartenliste die Karte adria_ne.wci aufgeführt? 
Beenden sie SeaClear und starten es erneut. 
Mit einem rechts Klick im Kartenfenster von SeaClear öffnet sich ein Untermenü Karte > zeige 
alle und wählen sie die adria_ne.wci an. In unserer ersten Übung wollen wir von Izola nach 
Umag segeln.  
Optional können sie auch mit  Datei: > Öffne Karte > zeige alle unsere Adria NE laden.  
Mit Bearbeiten > Routen Editor erscheint ein neues Arbeitsfeld in der 
Navigationsleiste und sobald der Cursor im Kartenteil auftaucht verändert er sich 
in ein:   neues Kreuz mit Pfeil.  
Mit links Einfachklick und Halten verschieben wir die Karte bis wir Izola gefunden haben. An 
der Hafenmole von Izola beginnt unsere Route.  
Damit wir diese genauer sehen können, klicken wir dort rechts und wählen Zoom > 200%. 
Dies geht auch wenn sie mit einer Maus mit Drehrad arbeiten und dies eingestellt (aktiviert) 
haben, indem sie das Drehrad nach vorne rollen. 

 Mit einem Doppelklick erzeugen wir den Startpunkt und benennen ihn im 
Navigationsfeld unter Name mit Izola und klicken sofort darunter auf 
Update.  
Mit rechts Klick > Zoom > 100% kommen wir wieder in die Normalansicht.  
Unser Weg führt uns mit gutem Abstand nördlich von Rtic Romek vorbei. 
Also Doppelklicken wir hier erneut und nennen diesen Wegepunkt Romek 
> Update. Der dritte Wegepunkt liegt nördlich vom Cap Madona – 
dieselben Schritte Doppelklick, Namensgebung und Update. Nun runden 

wir das Cap Savudrija – hier vergeben wir gleich 2 Wegepunkte. Savudrija1 liegt NNW vom 
Kap und Savudrija2 Westlich. Der vorletzte Wegepunkt  ist die Westliche Ansteuerungstonne 
von Umag (Name = Umag-West) und dann setzen wir unser Ziel an die Zollpeer von Umag, 
das wir schlicht Umag nennen.  
Mit dem Schnellschalter Speichere Route öffnet sich ein Unterfenster und verweist bereits auf 
den Ordner Route und schlägt einen Routennamen vor Izola – Umag.SRW . Sind keine 
Wegepunktnamen vergeben oder gefällt ihnen der Routenname nicht, ändern Sie ihn und 
speichern diesen.  
Nun wählen wir erneut den Zoom > 50% und haben die Karte mit der Route im Überblick.  
Wie lange ist sie und welche Zeit benötigen wir dazu. Dazu klicken sie in den Schnellschalter 
Routen Liste.  
Über Bearbeiten >Einstellungen > Route können sie die Durchschnittsgeschwindigkeit von 
der Vorgabe 5 kt auf ihr Schiff einstellen. Bei meiner Berechnung sind die 12 nm in knapp 3 
Stunden zu fahren.  
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In dieser Liste können wir alle Daten ändern (soweit nötig) und mit update bestätigen oder 
schließen diese einfach nach Ansicht wieder.  
Uns gefällt der Wegepunkt Savudrija2 noch nicht – er liegt zu nahe an der 
Küste.  
Ganz einfach – Linksklick und halten, dann ziehen sie ihn etwas weiter 
nach West: Mit Update der Schnellschalter wird er aktualisiert und nun muss nur noch die 
Route erneut gespeichert werden Speichere Route. Ändern sie nur die Position geschieht 
dies ohne Fenster, ändern sie einen Wegepunktnamen müssen sie einfach den angegebenen 
Routennamen bestätigen oder einen Neuen vergeben (update!). Mit dem Schnellschalter 
Schließe Editor sind wir wieder in der  Normalansicht.  
Die Route ist noch immer sichtbar und im Routen Statistik Fenster werden nun Start und 
Zielpunkt sowie die Gesamtentfernung angezeigt. Einfach genug? 
 

 
 
Machen wir übungshalber noch eine Route.  
Segeltörn von Umag, mit Badestopp in der Bucht von Dlja, nach Novigrad.  
Bearbeiten > Routen Editor > Lösche Route damit wir eine neue Route schaffen können.  
Sie planen nun, vergeben Routennamen und prüfen am Ende visuell diesen ca. 9 nm langen 
Törn.  
Ein Tipp dazu – wenn sie in eine Bucht hineinfahren und wieder im spitzen Winkel 
herauskommen berechnet SeaClear die kürzere Strecke. Wir können ihn aber überlisten 
indem wir die Punkte mit Linksklicken und Halten “nachverschieben” und dann die Namen 
ändern. Ist die Route komplett? Löschen sie die Route – sie wird nur vom Bildschirm entfernt. 
Komplett löschen können sie Routen oder Wegepunktdateien mit SeaClear nicht mehr. 
Nutzen sie dazu das Arbeitsplatz- oder Explorerwerkzeug.  
Wir sind in der Normalansicht und laden nun erneut mit Öffne Route aus dem Fenster die 
Route Umag – Novigrad.SRW und drehen sie mit Routenumkehr um. Würden wir tatsächlich 
in Novigrad sein würde dies SeaClear über die GPS Position bemerken und die Route 
automatisch umkehren. Da wir ein flottes Boot haben und nur übers Wochenende zum 
Segeln waren, wollen wir in einem Schlag nach Izola. Klicken also erneut Route öffnen und 
verneinen die Anfrage Alte Route löschen? Wir wählen die Route Izola – Umag.SRW und 
bestätigen dies.  
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Auf der Karte wird nun die neue Gesamtroute aufgezeigt und im Routen Statistik-Fenster 
angezeigt. Novigrad – Izola, Distanz 21 nm. Würden wir nun wirklich segeln, überspringen wir 
die Badebucht einfach. SeaClear bemerkt das und würde ab Dalja West weiterkalkulieren.  
Die neuen Routen kopieren wir auf ein Speichermedium und können sie an Bord mit dem 
Explorer in das Verzeichnis c:\navigate\seaclear2\routen verschieben.  
 
 

Wollen sie am Schreibtisch schon einmal segeln – 
zumindest Virtuell? Kein Problem! Klicken sie dazu nach 
Izola. Machen sie dort, genau an dem Punkt an dem sie 
ihr Schiff haben möchten, einen Rechtsklick > Bearbeiten 
> Setze DR Pos. Die DR Funktion übernimmt im Ausfall 
des GPS die Steuerung des Schiffes, basierend auf den 
letzten Daten. Da wir aber keine letzten Daten haben, 
setzen wir das Schiff manuell an eine gewünschte 
Position. Falls das 
Schiffsymbol nicht zu 
sehen ist wählen sie 

einen anderen Zoomwert. Nun ist unser Schiff zu sehen und 
wir tragen im roten GPS Feld Kurs und Geschwindigkeit ein.  
Ist der Schalter „Verlaufsspur EIN“ aktiv? Mit jeder 
Kursänderung (über 5°) wird der Verlauf dargestellt und wir 
können sehen ob wir an der geplanten Route entlang fahren oder korrigieren sollten – wie im 
wirklichen Segeln. Gut auf dem unteren Bild zu sehen ist der kleine „Vorhalte-Kreis“. 
Eingestellt auf 300 Sekunden = 5 Minuten. Den WP # Ronek werden wir also in etwas mehr 
als 5 Minuten erreichen und dann den Kurs wechseln. Wohin? Aktivieren sie ihre Route und 
wir finden die dazu nötigen Daten rechts. Was nun noch fehlt (und schlecht simuliert werden 

kann) – sind Windabdrift, Strom und Seekrankheit.  
Bei dieser Simulation wird ebenfalls eine Trackdatei geschrieben – diese kann z.B. in Google 
Earth dargestellt werden (siehe weiter unten). 
 
Mit jedem erneuten Start öffnet SeaClear die Software an der zuletzt bekannten Position mit 
der dafür besten Karte – also nicht mehr am Äquator. 
 
Damit haben Sie auch schon die wichtigsten Schritte vom Erhalt der Software bis zum 
Digitalen Segeln durchgeführt.  
Ein bisschen Praxis im Herumklicken auf einem PC und Sie werden Zirkel, Bleistift und 
Messdreiecke für immer im Kartenschapp liegen lassen  können.  
Und Strom und Windberechnung? Nun der PC fährt Lifezeit und plottet dies mit.  
Wir weisen unseren manuellen Rudergänger an, anzuluven oder abzufallen – bis Track und 
Routenlinie sich annähern oder zumindest nahe beieinander parallel verlaufen.  
Bis auf raueste See aber schlägt der Autopilot eh jeden menschlichen Rudergänger und der 
Automat erhält ja ab sofort “seinen” Kurs von SeaClear.  
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Sollten sie Spaß an dieser Digitalen Option der Navigation gefunden haben bietet die CD 
noch einige Erweiterungen für diesen Kartenplotter an. 
 

 
 

AIS Signale 
Die Berufsschifffahrt ist ab einer bestimmten Größe verpflichtet ein Automatisches 
Identifikations System zu betreiben. Dieses Signal wird per VHF (UKW) ausgestrahlt und hat 
eine quasi-optische Ausdehnung von 25 Meilen und mehr. Da hier ein GPS Signal 
eingespeist wird, werden viele wichtige Daten sehr exakt übermittel. Wenn auf ihrem Schiff 
ein AIS- Sende-/Empfänger oder Empfänger angeschlossen ist, kann SeaClear diese NMEA 
Daten als Ziele darstellen.  Dies ersetzt ein Radar nicht – aber mit AIS kann man abhängig 
von der Reflektion um die Ecke in einen Fjord / Bucht sehen – leider sind noch nicht alle 
Schiffe mit diesem System ausgerüstet. 
AIS Sender werden mit dem HDT Datensatz (soweit vorliegend) dargestellt, sonst mit COG 
(Kurs über Grund). Sollte das ROT Signal empfangen werden, wird ein Wendekreis 
angezeigt. Der Geschwindigkeitsradius hat denselben Vorhalt wie der von ihnen 
voreingestellte Speedmarker (=Erreichbarer Punkt in * Sekunden). Die Fahrtrichtung des AIS 
Zieles wird bei entsprechendem Kartenmaßstab angezeigt 
Im AIS Rollmenü werden alle AIS Sender dargestellt und bei jedem öffnen des 
Rollmenüs aktualisiert.   
AIS Sender. Bei einem Anklicken des Zieles wird die geplante Fahrrichtung falls möglich 
angezeigt, ansonst zeigt es den COG mit dem Wenderadius. Um weitere AIS Informationen 
des Zieles zu erhalten klicken sie Rechts auf das Ziel und wählen Bearbeiten->AIS Info. 
Darauf öffnet sich ein Popup Fenster das die relevanten Daten für dieses Schiff anzeigt – nun 
wird es viel leichter die Brücke dieses Schiffes mit VHF Funk direkt anzusprechen und 
Manöver 
abzusprechen. In 
verkehrsdichten 
Zonen reagieren die 
Schiffe der 
Großschifffahrt 
nämlich nicht 
mehr auf den 
Anruf  „Big ship, big 
ship – this is….“ 
Das 

ausgewählte AIS 
Signal wird mit 
einem 
gestrichelten 
Rechteck 
dargestellt!  
 
 

 
CPA Kollisionswarnung auf der Karte. 
Wenn sich die CPA (Closest Point of Approach = Nahester Punkt 
der Annäherung) und TCPA (Time to CPA = Zeit zum CPA Ziel) 
der Überwachungszonen nähern wird eine Warnung in Form von 
2 sich überschneidenden Ringen dargestellt.  
Der eine Kreis ist das eigene Schiff mit Berechnung COG (Kurs 
über Grund) und der voreingestellten CPA Max (Zeit oder 
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Entfernung). Der zweite Kreis ist das gegnerische AIS Signal (Schiff) mit COG 
Darstellungsrichtung, Schiffsname und (falls möglich) der Schiffslängenradius. Die CPA 
Warnung wird solange angezeigt wie TCPA (Kollisionszeitpunkt) zwischen 0 und TCPA Max 
liegen und CPA kleiner als CPA Max zuzüglich der Schiffslänge ist. Die CPA Daten werden 
dabei fortlaufend mit allen AIS Sendern, die dargestellt werden, neu berechnet.  
Sobald eine berechnete Warnsituation nicht mehr vorliegt, wird sie auch nicht mehr 
dargestellt. Um Warnsituationen nicht auf dem Bildschirm angezeigt zu bekommen muss der 
TCPA Max Wert auf  0 gestellt werden.  
 
Beachte: Bei SeaClear muss evtl. die Baud-Geschwindigkeit bei AIS Empfang unter 
Bearbeiten > Com verändert werden (geschickt wird der Datensatz 
$PNMLS,ss,tt,r*cc<CR><LF> mit  38.400 Baud). 

 

Track bei Google Earth darstellen 
 
Die Speicherdatei für Tracks (Verlaufsspur) liegt im Unterordner ..\SeaClear\traces  mit einer 
Endung die für die Darstellung in Google Earth nicht sehr hilfreich 
ist. Die Datei kann aber als *.txt Datei exportiert werden.  Öffnen 
sie dazu SeaClear und schalten die automatische Track-
Aufzeichnung Verlaufsspur AUS. Solange die 
Trackaufzeichnung aktiviert ist, zeichnet SeaClear permanent die 
Schiffsbewegung auf und vergibt ab 0:00 Uhr (täglich neu 
beginnend) einen neuen Dateinamen. Wir können also einen Tag oder mehrere Tage laden 
und dann exportieren. Beim Export wird eine *.txt Datei erstellt.  
 

       
 
Wenn die folgende Musterzeile kopiert wird und als Zeile 1 (siehe Muster) eingefügt wird, 
kann GPS Babel (ein Übersetzer für GPS Protokolle – s.weiter unten) dieses Protokoll in 
andere Formate umschreiben – so auch in ein Format das in Google Earth dargestellt wird.  
Musterzeile: 
 
Date,Time,Latitude,Longitude,speed,sat 
 
 
Eine *.txt Datei wird mit einem 
Linkdoppelklick automatisch 
mit dem Win-Editor geöffnet.  
Mit dem Cursor vor dem ersten 
Eintrag wird mit einem 
Zeilumbruch eine neue leere 
Zeile erstellt. Kopiert man nun 
die Musterzeile hier hinein und 
speichert die Datei ist sie 
vorbereitet für eine Umwandlung in GPS Babel.  
 
BEACHTE: Speziell für SeaClear gelten folgende Einstellungen: 
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Die Software und eine Erklärung was wie eingestellt werden sollte, ist auf der CD unter 
..\Nautik\Seekarten für Google Earth . Track in Google darstellen.pdf beschrieben.  
 
Speziell für SeaClear aber gilt: 
 

 
 

1. Universal… Input Datenformat einstellen 
2. Startdatei (mit Musterzeile) auswählen, dabei den Rollbalken Dateityp auf „Alle 

Dateien“ einstellen 
3. Google Earth… Ausgabeformat 

wählen 
4. mit einem Linksklick in das Buch 

Icon folgende >>> 
Einstellungen auswählen/ändern 

  
Wählen sie „Routen“umrechnung 
aus 
5. Im Filter wird ebenfalls die max. 

Anzahl auf 100 herabgesetzt 
 

  mit Linksklick  wird die 
neue *.klm Datei erstellt.  
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Sobald diese Datei  aus einem Explorer doppelt geklickt wird, startet automatisch (Google 
Earth bereits installiert) die Anwendung und stellt 
die Datei als Tracklinie dar. Sie sollte in ihren 
Ordner mit Linksklick und ziehen in „Eigene Orte“ 
verschoben werden. Mit einem Rechtsklick in die 
Datei kann mit Umbenennen die Datei in einen 
passenden Dateinamen (z.B. Datum und Strecke) 
geändert werden.   

 
 
 
 
 
 
 
 
 

G7ToWin für den Datenaustausch mit einem GPS 
Falls sie Daten an ein Einbau- oder Hand GPS senden oder empfangen möchten 
(Wegepunkte oder Tracks) installieren sie die Go7ToWin.exe  in das Verzeichnis in dem auch 
die seaclear.exe liegt. Dabei die ..\SeaClear\g7towin.Zip-Datei der NavCD zuerst in ein 
Temp-Verzeichnis entpacken und dann mit einem Doppelklick die Installation beginnen. 
Beachte: Einige GPS Geräte benötigen eine NMEA-Protokollumstellung um mit G7ToWin 
Software Daten austauschen zu können. Die G7ToWin Version A.00.140 wurde getestet, 
neuere Versionen sollten ebenfalls funktionieren. 
Weitere Hinweise sind in der Deutschsprachigen Betriebsanleitung aufgeführt 
 

Trackpunktauswertung 
 
Mit einem weiteren Zusatzprogramm können sie ihren letzten Törn digital auswerten. 
Entpacken sie dazu die …\SeaClear\seatrackedit.zip in ein Temp Verzeichnis und starten von 
dort die Installation durch einen Doppelklick auf die setup.exe.  
Über das Startmenü oder einem selbst erstellten Desktop-Icon kann die Software auch ohne 
den Betrieb von SeaClear gestartet werden. In dem nun geöffneten Fenster wählen sie zuerst 
eine gewünschte Verlaufsspur (Track-Datei) aus dem Unterverzeichnis …\SeaClear\traces 
aus.  
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Die oder mehrere Tracks können geladen und mit einem Klick auf den Plot Route Schalter 
dargestellt werden.  
 

 
 
 
 
Jetzt wird ihre Route grafisch dargestellt und mit den jeweiligen Einstellungen können die 
Kurse als Richtung und Geschwindigkeit farblich dargestellt werden.  
 
 
 

 
 
 
Trimmauswertung 

 
Mit dem Zusatzprogramm SeaTrace können sie viele NMEA Signale darstellen und (sobald 
angeschlossen) ihr Schiff optimal trimmen und digital 
auswerten. Entpacken sie dazu die …\SeaClear\seatrace.zip in 
ein Temp Verzeichnis und starten von dort die Installation durch 
einen Doppelklick auf die setup.exe.  Legen sie den Pfad so 
dass es in das Hauptmenü von SeaClear installiert wird.  
Bevor sie nun die Software über Start > oder ein Icon starten, 
müssen sie aber die seaclear.ini umschreiben. Doppelklicken 
sie also im Verzeichnis …\Navigate\SeaClear die 
SEACLEAR_2.INI an (oder öffnen diese mit einem Editor) und 
tragen wie in unten stehen Beispiel DDE=1 in das Setup ein. 



Praxishandhabung Kartenplotter SeaClear  - 23 - © Skipper UDO  skipper-udo.de 

 
 
 

 
 
Wird nun die Software SeaTrace gestartet lädt sie auch automatisch SeaClear und stellt die 
nötigen Fenster dar. Die Werte in den Zellen können verändert werden.  
Für weitere Infos siehe im dortigen Hilfsmenü.  
 
 
 
 
 
 
Ein kleiner Tipp zum Schluss: sobald sie mit der Menüoption vertraut sind, sollten sie sich 
das Manual nochmals durchlesen. Viele weiter zusätzliche Einstellungen und 
Arbeitserleichterungen (w.z.B. Shortcuts, sind dort genau beschrieben). 
 
Beispiel: 

o SeaClear errechnet und zeigt im Nav-Fenster oben, ständig die aktuelle Missweisung 
an. 

o Sollten die GPS Daten vorübergehend fehlen, plottet SeaClear den Kurs und 
Geschwindigkeit weiter (basierend auf die letzten Daten)  

o Egal in welcher Karte sie gerade herumstöbern, mit einem Doppel-Klick im 
Koordinaten Fenster sind sie wieder bei ihrem Schiff 

o Route zu kompliziert? Rechtsklick auf der Karte zum gewünschten Zielpunkt > 
Wegepunkt > Setze Markierung und schon werden Peilung und Entfernung 
permanent unten rechts angezeigt (mit einem Rechtsklick auf den WP kann er wieder 
deaktiviert werden)  

o Rechtsklick am gewünschten Startpunkt in einer Karte > setze DR Position und schon 
kann man ohne GPS eine Fahrt simulieren. Hierzu im Roten Koordinatenfeld nur den 
gewünschten Kurs und Geschwindigkeit eingeben. 

 
 
Bis zum nächsten Stromausfall wünsche ich einen wundervollen Wochenend-Törn (oder 
wollen sie gleich um die Erde?) und viel Spaß mit Elektronischer Navigation!   Skipper UDO 


